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1. Introduction 
Voice Reader Home 15 is a speech output program that uses remarkably natural sounding 
voices and is available in many voices for many languages. Voice Reader Home 15 converts 
any of your texts to voice professionally on your PC – either to listen to it immediately or to 
export it to audio files, e.g. for transfer to a smartphone or MP3 player. This manual will 
explain how to set up and use Voice Reader Home 15 on your PC.  
 
Thank you for choosing Voice Reader Home 15.  We hope you enjoy using it! 
 
For more information on Linguatec and other speech technology products, please visit our 
homepage at www.linguatec.net . 

 

1.1 Technical Support 
 

Support on the Internet 
If you experience any problems that cannot be solved using the manual or the online help, 
please visit our comprehensive support area on the Internet: 
www.linguatec.net/services/support  
 
You will find a compilation of the most frequently asked questions (FAQs) there.  Experience 
has shown that it already contains detailed instructions for quickly resolving almost all user 
questions.  
 

Personal support 
If you have a specific problem that cannot be resolved using the FAQs, we will gladly provide 
you with personal support. Support will be provided via email and is free for registered users, 
for up to 90 days following the purchase of Voice Reader Home 15.  Therefore please take 
care to correctly enter your personal information when activating the program.  
All questions directed to support must include the following information: 

 Program version  

 Operating system 

 Description of the error, including any error messages received 
Please use the support form for your questions: www.linguatec.net/services/support/form   
 

General Questions and Suggestions 
Please contact us if you have any questions regarding additional languages or voices, business 
solutions, or other language technology products. Use the contact form provided at: 
www.linguatec.net/contact   

 
Your suggestions for Voice Reader Home 15 and this manual are always welcome, and we will 
make every effort to consider them in the continuing development of our products.  
 
 
 
 
 

http://www.linguatec.net/
http://www.linguatec.net/services/support
http://www.linguatec.net/services/support/form
http://www.linguatec.net/contact
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1.2. System Requirements  

Before installing Voice Reader Home 15, please make sure that the system requirements are 
fulfilled: 
 

 Operating system: Windows Vista, Windows 7 or Windows 8 (32- and 64-bit) 

 Available hard disk space: Up to 1 GB per installed Voice Reader Home 15 voice 

 Memory: 2 GB RAM 

 Internet connection for product activation 

1.3 Installation 

Please note that you must be logged in as an administrator to install Voice Reader Home 15. 
Make sure that installed antivirus programs or the firewall are not blocking any processes 
required for installation. Before starting the installation, save any open documents and close 
all applications.  
 

Installation from CD: 
Insert the Voice Reader Home 15 CD into your computer’s CD drive to start the installation. In 
the event that the installation does not start automatically, execute the setup.exe file 
manually.  For example: Locate and open the CD drive in Windows Explorer, then right-click 
the file setup.exe in the CD folder.  From the context menu, choose the option Run as 
administrator. Follow the instructions on your screen. 
 

Installation by download:  
If you have purchased Voice Reader Home 15 as a download, follow the link sent to you by 
your online vendor and save the Voice Reader Home 15 installation file to your computer.  In 
this case, also right-click the setup.exe and choose the option to Run as administrator. Then 
follow the instructions of the installation wizard.   

1.4 Installing additional voices 

If you have already installed a voice of Voice Reader Home 15 and now wish to add an 
additional voice (also for an additional language), simply run the setup.exe installation wizard 
with the new voice from the CD or the downloaded folder.  The existing installation will be 
recognized, and the additional voice will be installed. 
 

1.5 Product activation 

The unlimited use of Voice Reader Home 15 requires the activation of the product using the 
license key provided. You will find the 25-character license key on the CD or the CD cover. If 
you purchased a download, the online vendor will send the license key to you following 
completion of the purchase. 
Voice Reader Home 15 must be activated with an activation code within 30 days following 
installation. The activation code is generated during activation using the license key entered 
and your computer’s hardware code.  
As long as Voice Reader Home 15 has not been activated, the Activation Wizard will be 
displayed each time the program is started. Product activation requires an internet 
connection.  
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There is a choice of two activation methods. 

 Instant activation: If the PC on which Voice Reader Home 15 has been installed is 
connected to the Internet, product activation can be performed online within moments.  

 Manual activation: In the event that instant activation  is not possible (e.g. when the PC 
with Voice Reader Home 15 is not connected to the Internet), you can go online from any 
other PC to retrieve your activation code on the Linguatec activation website, and then 
manually transfer it to your PC.  

 

Important notes on product activation 
Since it uses a hardware code, the product activation is connected to the PC on which Voice 
Reader Home 15 is installed. The code that you receive for activation can therefore be used 
only on the PC from which you have initiated product activation and generated the hardware 
code.   
The product must be reactivated after each reinstallation.  
Reactivation will also be required if you install an additional language for Voice Reader Home. 
 

1.5.1 Instant activation 

Instant activation requires that the PC on which Voice Reader Home 15 has been installed is 
connected to the internet. If this is the case, this is the preferred method of activation, 
because - apart from the license key - no further codes need to be entered manually, and 
product activation is completed within moments.   
If your program version has not been activated, the activation dialogue will be displayed each 
time you start the program.   
If you want to perform the activation later, click on the Activate later button.    
For up to thirty days following installation, you can use Voice Reader Home 15 without 
activating the product.   
 

Do the following to perform the activation: 
 

1. Choose the language in which you want the following activation dialogue windows to be 
displayed, and then click on Activate now.  
 

2. In the following dialogue, enter your license key into the field next to the program version 
that you wish to activate.  
In the CD version, the license key is included in the box.  
If you have purchased your program version as a download from an online shop, you should 
have received your license key by email. (If you have not yet received your license key, please 
contact the online vendor directly.) 
 

3. Enter your name and your email address. Make sure that your name and email address are 
entered correctly.  This is required to receive support and to take advantage of our update 
offers.  
 

4.  Click on the Continue button to move on to the next dialogue box. Under Activation 
method, make sure that the option Instant activation is selected.  Under Proxy settings, leave 
the default option checked (»Do not use a proxy server«), and click on Continue to complete 
activation. 
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5. You will receive a message confirming successful activation. You now have unlimited use of 
Voice Reader Home 15 on that PC. 
 

If the connection to the activation server fails, you may have to adjust the proxy settings. First 
try the option Use Internet Explorer settings... If this also does not work, manually enter the 
proxy server and the corresponding port.  In case the instant activation fails, please contact 
your system administrator, or perform a manual activation (see Chapter 1.5.2). 
 

1.5.2 Manual activation 

Perform the manual activation if the PC on which Voice Reader Home 15 is installed is not 
connected to the internet, or if the instant activation has failed.  Otherwise, instant activation 
is simpler and faster.   
In the case of manual activation, a hardware code must first be generated on the installation 
PC (s. item 5 below). With this hardware code and your license key, you can use any other PC 
to access the Linguatec activation website (www.linguatec.net/activate) to generate an 
activation code which must then be entered on the installation PC to activate the product.  
If your program version has not been activated, the activation dialogue will be displayed each 
time you start the program.   
If you want to perform the activation later, click on the Activate later button.  For up to thirty 
days following installation, you can use Voice Reader Home 15 without activating the product.  
Do the following to perform the activation: 
 

1. Choose the language in which you want the following activation dialogue windows to be 
displayed, and then click on Activate now.  
 

2. In the following dialogue, enter your license key into the field next to the program version 
that you wish to activate. In the CD version, the license key is included in the box.  If you have 
purchased your program version as a download from an online shop, you should have 
received your license key by email. (If you have not yet received your license key, please 
contact the online vendor directly.) 
 

3. Enter your name and your email address. Make sure that your name and email address are 
entered correctly.  This is required to receive support and to take advantage of our update 
offers.  
 

4.  Click on the Continue button to move on to the next dialogue box. Under Activation 
method, choose the option Manual activation and click on the Continue button to perform 
the activation. (Proxy settings are irrelevant for manual activation.) 
 

5. In the following dialogue, the hardware code required for the generation of the activation 
code will be displayed next to the program version. Click on the link Activation form to open a 
HTML document containing the license key you have entered (s. item 2 above) and the 
hardware code.  Either print this form or save it to a mobile data medium (e.g. USB stick).  
Should neither be possible, make a note of the hardware code and your license key.  
 

6. Connect to the Linguatec activation website (www.linguatec.net/activate ) from any PC and 
enter your license key and the hardware code to generate the activation code. 
 

7.  Either print the form containing the activation code or make a note of the code on the  

http://www.linguatec.net/activate
http://www.linguatec.net/activate
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print out of the activation form.  Please make sure to use exactly the same writing, especially 
the correct upper and lower case. 
 

8.  Return to the Product activation:  Manual activation dialogue on your PC. If the dialogue 
has already been closed, please restart Voice Reader Home 15 to bring up the product 
activation again. Then repeat steps 1 to 4 as described above. 
 

9.  Enter the activation codes received on the activation website into the corresponding field.   
 

10. Click on the Continue button to complete the activation. 
 

11. You will receive a message confirming successful activation. You now have unlimited use 
of Voice Reader Home 15 on that PC. 
 

1.6 Uninstallation 
To uninstall Voice Reader Home 15 from your PC, use the standard Windows function.  
Switch to the Windows Control Panel.  
 

In Windows Vista / 7: Start menu > Control Panel 
 

In Windows 8: Right-click the lower left edge of the desktop and choose Control Panel from 
the pop-up menu.   
In the Control Panel, click on the area:  Programs and Features. A list of installed programs 
will be displayed.  
Highlight the entry for Voice Reader Home 15 and click on Uninstall. 
 

If you are asked for an administrator password or confirmation, then enter the password or 
the confirmation.  
 

2. Using Voice Reader Home 15 
Start Voice Reader Home 15 from its desktop icon or from the program menu. 
Voice Reader Home 15 allows you to immediately convert text to speech (Chapter 2.3), 

or to export it into an audio file (Chapter 2.4) for playback at a later time. This chapter 
explains how to use the features in the Voice Reader Home 15 application window. Many of 
these features are also available in Voice Reader Home 15 Direct (Chapter 3).   

 
The Voice Reader Home 15 application window:  
Here you can open and edit text documents before having them read or exported to an audio file. 
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2.1 The User Interface 

 
The Voice Reader Home 15 interface, with scalable editor, multi-function ribbon, tabs, Quick Access toolbar  
and Voice Reader Home 15 read button.   
 

Besides the scalable editor, the well-designed application window of Voice Reader Home 15 
includes a comprehensive multi-function ribbon with tabs that contain logically organized 
groups. From these, all the features of Voice Reader Home 15 can be easily operated.  
Also available is a customizable Quick Access toolbar.  

The Voice Reader Home 15 Read button lets you start the reading by mouse-click, 
directly, from any tab. 
 

The following provides an overview of the tabs, groups, and buttons available in Voice Reader 
15.  Each button has a Mouse Over text that is displayed when you hover (without clicking) 
the mouse cursor over the respective button.   
 

File Tab 

 
 

 Group: General 
Create a new document ( New button), open an existing document (Open button ), save an 
open document (Save or Save As buttons), select one of the printing options (Quick Print, 
Print or Print Preview buttons)  and go one step back or forward (Undo or Redo buttons). 
 

Read Tab 

The Read Tab includes all features related to speech output. Chapter 2.3 contains detailed 
descriptions of all the options. 
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 Group: Language and Voice 
This is where you can determine the language that corresponds to the text, as well as the 
desired voice.  Voice Reader Home 15 will use this voice to read the text in the editor. The 
available voices are your purchased Voice Reader Home 15 voices. 
 

 Group: Read 

Determine what is to be read. The choices are Document , Selection  or From Cursor 

Position (cursor position)  
 

 Group: Export 

Select the text which is to be exported into an audio file. The choices are Document , 

Selection  or From Cursor Position (cursor position)  
 

 Group: Settings 

In this group, you can determine the reading and export options (Button: Options ).  
 

Speed , Pitch and Volume  can also be easily and individually adjusted using slide 

controls, and if necessary, can be returned to their original state using a Refresh-Button .  
 

Edit Tab 

 

 Group: Clipboard 
This group contains buttons for inserting text from the clipboard, cutting or copying text, or 
inserting content.  
 

 Group: Font 
Font, font style, font size, font color or text effects can be configured here. 
 

 Group: Paragraph 
Determine indents and spacing, line and page breaks or tab stops in your text. 
 

 Group: Styles 
In this group, you can choose your style template.  
 

 Group: Editing 
This contains the buttons to search text (Button: Search), replace text (Button: Replace), or 
select text (Button: Select all). 
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View Tab 

 

 Group: Document Views 
Choose one of the possible views: Draft View, Print Layout or Simple View  
 

 Group: Show 
Show or hide a horizontal and/or vertical ruler. The availability depends on the selected 
document view.  
 

 Group: Zoom 
The Zoom out and Zoom in buttons let you adjust the zoom factor of the text area.  
 

 Group: Page Setup 
In this group you can choose the orientation of your page. The Options are portrait or 
landscape format. 
 

 Group: GUI Language 
Choose the language of Voice Reader Home 15’s user interface from the GUI Language list.  
 

Other Tabs 

Depending on the file opened and the style templates it contains, other tabs may be displayed 
in Voice Reader Home 15.  
For example:  
Design (to draw or adjust table styles such as shading or frames)  
Layout (to adjust table properties, especially the administration and arrangement of lines and 
columns) 
 

The Voice Reader Home 15 Read-Button 

With just one click onto the green Voice Reader Home 15 Read-Button, you can start 
the Read feature from any tab. The entire text loaded in the editor will be read 

immediately. If a section of the text has been selected, only the selection will be read.  
When reading is started via the Voice Reader Home 15 Read-Button, it will use the reading 
options set under the Read Tab.  
 

The Quick Access Toolbar 

The buttons on the Quick Access toolbar remain visible at all times and are therefore a 
beneficial tool for working rapidly and efficiently.  
Depending on personal preference, the toolbar can be placed above or below the multi-
function ribbon.  To place the toolbar, right-click a vacant area on the multi-function ribbon 
and choose one of the following options:  
Show Quick Access Toolbar above the Ribbon or  

Show Quick Access Toolbar below the Ribbon.  
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Quick Access toolbar above the multi-function ribbon  
 

 
Quick Access toolbar below the multi-function ribbon  
 

By default, the Quick Access toolbar is populated with the Voice Reader Home 15 reading 
functions. Further elements can be added to the toolbar by right-clicking the desired element 
in the multi-function ribbon and selecting Add to Quick Access toolbar.  
(NOTE that the reading options voice, language, speed, pitch and volume cannot be started 
through Quick Access).  
To remove tools, right-click on an element in the Quick Access toolbar and select Remove 
from Quick Access toolbar. 
 

Customizing the multi-function ribbon 

 
Multi-function ribbon minimized 
 

 

Multi-function ribbon maximized 
 

If you do not wish to display the Voice Reader Home 15 multi-function ribbon all the time, e.g. 

to save screen space, you can hide it by selecting Minimize the Ribbon.  The option appears 

when you right-click a vacant area on the multi-function ribbon. When the multi-function 

ribbon is minimized, tabs can still be activated by clicking on them.  Once a command has 

been selected, they will automatically be minimized again.  To maximize the multi-function 

ribbon, please switch to one of the tabs, right-click a vacant area, and remove the checkmark 

next to Minimize the Ribbon.   
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The Context Menu 

The context menu can be opened by right-clicking on any point in 

the text. Important reading functions are thus always and quickly 

at your disposal while editing longer documents.  

The context menu includes all commands that are beneficial and 

applicable at that point.  

Non-available commands are displayed as inactive.  

Example:  

When no word or sentence has been selected in the text, the 

option Read selection will be greyed out in the context menu, 

and therefore cannot be executed.   
 

 

2.2. Opening and editing documents in the application window 

Opening a file 

The following file formats are supported by Voice Reader Home 15 and can be loaded directly 

in the application window using the File - Open command: 

  Text files  (*.txt ) 

  RTF files  (*.rtf ) 

  Word files  (*.docx, *.doc ) 

  HTML files  (*.htm, *.html )  

  MHT files  (*.mht ) 

  Epub files  (*.epub ) 

  PDF files  (*.pdf ) 

  ODT files  (*.odt ) 
 

To open a file, follow these steps: 

1. Switch to the File tab and click the Open button. 

2. Under File type, select the desired format or choose All supported files.  

3. Switch to the required folder, click on the file you wish to open, and then confirm your 

selection by clicking Open. 

NOTE 
A PDF file that you open in Voice Reader Home 15 must first be converted to the RTF 

format.  You will receive a message to that effect when loading the PDF file - confirm by 

clicking OK. Due to the RTF-conversion the graphics of the original PDF cannot be loaded 

into the editor of Voice Reader Home 15.  
 

Inserting or exchanging text via the clipboard 

You can also insert text from other applications directly via the clipboard. 

1. Select the desired text in the other application. 



Linguatec Voice Reader Home 15                                                                                                      13 

 

2. Copy the selected text to the clipboard (CTRL+C or Edit - Copy). 

3. Click into the editor window of Voice Reader Home 15 and paste the copied text using the 

standard key combination CTRL+V (or SHIFT+INS). If the editor already contains text that you 

wish to replace with the new text, select the existing text prior to pasting.  
 

Opening text by Drag & Drop 

You can also open a file in Voice Reader Home 15 by simply dragging and dropping it into the 

editor. (Drag & Drop: Click on the file with the mouse, keep the mouse button held down 

while dragging, release over the new location) 

Make sure that the selected file belongs to a supported file type.  
 

Saving text 

If you have made changes or inserted text into an open document in the Voice Reader Home 

15 application window, you can save the document. Switch to the File tab and select the 

command  

a) Save, if the document you have edited is to be saved with all changes under the same 

name and in the same location from which it was opened.  

b) Save As, if you wish to determine and possibly change the name and location of the 

document.  This way, you avoid overwriting with your changes and losing the original 

version of the document you have edited.  

Voice Reader Home 15 supports saving to the following file formats: 

 Text files   (*.txt ) 

  RTF files   (*.rtf ) 

  Word files   (*.docx, *.doc ) 

  HTML files   (*.htm, *.html )  

  MHT files   (*.mht ) 

  Epub files   (*.epub ) 

  ODT files   (*.odt ) 
 

Printing text 

You can print out the text that is in the application window of Voice Reader Home 15.   

Switch to the File tab and select one of the following commands: 

Print, Quick Print (this executes the print command immediately, without first bringing up the 

print dialogue) or Print Preview. 
 

2.3. Reading text 
Before starting playback, you should confirm that the desired settings for voice, speed, pitch, 

volume and text reading selection have been selected from the Options in the Read Tab.  

These cannot be changed while reading.  
 

Starting and stopping reading 

The Read Tab contains the following reading options:  
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Read entire text 

If the entire text open in the Voice Reader Home 15 editor is to be read, click on the 

Read Document button. 
 

 Read selected text 

Select the portion of the text you wish to have read and choose Read Selection. Voice 

Reader Home 15 will read only your selection.  

If possible, make sure to select only complete sentences, so that Voice Reader Home 15 can 

intonate the text correctly. 
 

 Read text from cursor position 

Place the cursor at the text location from which reading should commence and click on 

Read from Cursor Position. With this command, Voice Reader Home 15 will read the 

entire text following the cursor position.  
 

The Voice Reader Home 15 Reading Bar  

  

Once reading has been started, the Voice Reader Home 15 Reading Bar will open in a separate 

window. It can be freely moved around the display.  

To pause reading, please press  Pause.  

To continue reading, press  Play.  

Clicking  Stop will end playback prematurely. You can also do this by using the Close 

window function.  

The  Forward and  Reverse buttons allow you to navigate through the text, i.e. you can 

jump ahead to the next sentence or go back one sentence.  
 

Depending on the reading unit selected (Read Tab - Settings group - Options menu), reading, 

selecting and navigating the document will be by word, by sentence or by paragraph.   
 

If you have selected the option Read by sentence, the text to be read will be segmented by 

sentence. It will be selected and read by sentence.   

The Reading bar will display the number of sentences selected for reading (Example: Sentence 

2 of 9). The Forward and Reverse buttons let you move forward or back in the document one 

sentence at a time.  
 

If, however, you have chosen Read by paragraph, you can navigate the document one 

paragraph at a time. Selection and reading will be by paragraph.  

The segments to be read will be displayed by paragraph (Example: Paragraph 1 of 20).  
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The Forward and Reverse buttons let you move forward or back in the document one 

paragraph at a time. 
 

In the same way, if Read by word has been selected, segmentation of the text will be by word. 

Selection and reading will be by word.  

The Reading Bar will display the number of words selected for reading (Example: Word 3 of 7).  

The Forward and Reverse buttons let you move forward or back in the document one word at 

a time.  
 

In most cases, the preferred method will be to read by sentence.   
 

NOTE 

Please note that in the course of reading and while the Reading Bar is being displayed, the 

text cannot be changed, and settings cannot be adjusted.  To do either, the Reading Bar 

must first be closed. This can be done using the Stop button  or the Close function .  
 

During speech output 

During the playback mode it is not possible to change the voice, pitch, speech speed, volume 

or text marking.  You must first end playback using the Stop button or the Close function in 

the Voice Reader Home 15 Reading Bar, and then make the desired changes to Voice Reader 

Home 15 in the Settings area of the Read Tab. 
 

One-click reading using the Voice Reader Home 15 Read-Button  

By clicking the Voice Reader Home 15 Read-Button, you can start reading from any 

tab. The entire text loaded in the editor will be read immediately. If a section, 

sentence or word has been selected in the text, then only the selection will be read.   

When reading is started via the Voice Reader Home 15 Read-Button, it will use the reading 

options set under the Read Tab.  
 

2.4 Exporting text to an audio file 

Exporting converts the entire document in the application window, or a section of it that has 

been selected, to an audio file, which you can subsequently play back through a PC audio 

player, or transfer to an external medium or device such as an audio CD or an MP3 player.   

Which format (MP3 or WAV) is used and where the file is saved depends on the 

corresponding options selected in the Settings group of the Read Tab. 
 

Starting export 

The following options for exporting to an audio file (wav or mp3) are available in the Export 

group of the Read Tab:  
 

 Export entire text  

To export the entire text to an audio file, click on the Export Document button. 
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 Export selected text  

If you wish to export only a section of the text, select it. 

Take care to select only entire words, and if possible, complete sentences. Start the 

export by clicking on Export Selection.  
 

 Export text from cursor position  

Place the cursor at the desired location in the text, and then click Export from Cursor 

Position.  All text from the cursor position to the end of the text will be exported to an 

audio file. 
 

3. Voice Reader Home 15 Direct 
 

Voice Reader Home 15 Direct allows you to quickly have any text read from any 

application. Voice Reader Home 15 Direct is a tool that remains inconspicuously 

hidden in the information area of the Windows taskbar when it is not needed, but is instantly 

available when you want to have a document section read, or saved to an audio file.  
 

3.1 Starting Voice Reader Home 15 Direct 
Start Voice Reader Home 15 Direct by selecting the entry of the same name from the 

Linguatec – Voice Reader Home 15 program group in the Windows Start menu, or by clicking 

onto the Voice Reader Home 15 Direct desktop icon.  
After Voice Reader Home 15 Direct has been started, you will see an additional icon  in the 

taskbar notification area.  

If the Voice Reader Home 15 Direct application window is minimized, you can maximize it by 

double-clicking the application icon in the taskbar notification area.   

 
The taskbar notification area is on the bottom right. After Voice Reader Home 15 Direct has been started, you will 
find an additional icon here. By double-clicking the icon, you can maximize the minimized window. 
 

3.2 Showing and Hiding Voice Reader Home 15 Direct 
Voice Reader Home 15 Direct provides a toolbar containing buttons with which the   

most important commands  (Read text from the clipboard     , Export text from the clipboard 

   , Options  , Clipboard settings  , Hide editor  , Show editor   , Minimize   , Read 

 and Export ), can be run directly.   

 
The Voice Reader Home 15 Direct Toolbar. 
 

In addition, the Voice Reader Home 15 Direct editor can be opened. You can enter text into it,  

or insert text from the clipboard, which can then be read or exported into an audio file. 
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You can enter text into the editor, or insert text from the clipboard.  
 

Show and hide the Voice Reader Home 15 Direct Editor 

To hide the editor, click the Hide button  in the   

Voice Reader Home 15 Direct Toolbar. Click the Show button  to show it again.  
 

Show and hide the Voice Reader Home 15 Direct application window 

 To hide the entire Voice Reader Home 15 Direct application window, select the Minimize 

icon   in the toolbar.  

Do not click on the Close icon  in the title bar to minimize.  This would terminate Voice 

Reader Home 15 Direct. 

 To restore the hidden Voice Reader Home 15 Direct application window, double-click the 

Voice Reader Home 15 Direct icon in the taskbar notification area. 
 

3.3. Voice Reader Home 15 Direct reading and export options 

The Options button  lets you customize all available reading and export options.  

 

The Reading options 

In the Voice Reader Home 15 Direct reading options, you can configure the available 

parameters for speech output.  Besides language and voice, the speech speed, tone pitch, 

and volume can be customized.   
 

Export options 

You can configure the settings for the audio file format (MP3 or WAV) in the Voice Reader 

Home 15 Direct export options, as well as the export location (Standard export path). 

Confirm changes to the settings by clicking OK.  To disregard any changes entered, simply click 

Cancel. 
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The reading and export options of Voice Reader Home 15 Direct 
 

3.4 Voice Reader Home 15 Direct automatic settings  
(One-Click Clipboard Access) 

The built-in One-Click technology is the easiest way to use Voice Reader Home 15 Direct. It 

allows you to select the text to be read and simply press the key combination CTRL+C. Click 

the Automatic settings button  (in the Voice Reader Home 15 Direct toolbar) to open the 

options dialogue, where you can determine precisely whether and how Voice Reader Home 

15 Direct will use the contents of the clipboard.  

 
The Clipboard Options of Voice Reader Home 15 Direct 
 

Activate One-Click Clipboard Access 

If you want to easily control the reading, export or pasting functions of Voice Reader Home 15  

Direct by using One-Click (CTRL+C), you must first allow access to the clipboard. You can do 

this by checking the box next the line Activate One-Click Clipboard Access (CTRL+C) 
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Copy text to clipboard  

To copy text to the clipboard, select the desired text with the mouse in any application, then 

press CTRL+C. 
 

Available clipboard settings  

Depending on how the One-Click function has been assigned, the following actions can be 

initiated by marking text and pressing CTRL+C: 
 

1.  Automatic reading: Replace the text in the editor with the contents of the clipboard and 
read it automatically. 
This command will automatically read the contents of the clipboard.  

Also, the text being read will be inserted into the Voice Reader Home 15 Direct editor.  With 

this option, any existing text in the editor will be overwritten.   
 

2.  Automatic export: Replace the text in the editor with the contents of the clipboard and 
export it automatically. 
This command will automatically export the contents of the clipboard. You will be prompted 

to confirm the name for the audio file and determine the export location. Also, the text in the 

clipboard will be inserted into the Voice Reader Home 15 Direct editor.  With this option, any 

existing text in the editor will be overwritten.   
 

3.   Automatic paste: Paste the contents of the clipboard into the editor.  

This command will automatically paste the contents of the clipboard into the Voice Reader 

Home 15 Direct editor.  With this option, any existing text in the editor will not be 

overwritten.  The new text will be added. This option is useful if you wish to combine text 

from various applications before having it read or exported to an audio file.   
 

Keep window always in foreground 

If you do not want Voice Reader Home 15 Direct to be covered by any other window on your 

screen, this command lets you determine to always keep the Voice Reader Home 15 Direct 

window in the foreground.   

 

3.5 Using One-Click to automatically read, export and paste 

The One-Click function allows you to utilize Voice Reader Home 15 Direct quickly and easily.  

Chapter 3.4 describes the available settings in detail. 
 

Simply select the desired section of text in any text-based document (e.g. a website, an email, 

news,...) and have it read, exported to an audio file, or inserted into the Voice Reader Home 

15 Direct editor by pressing CTRL+C.  

Using One-Click to read text with Voice Reader Home 15 Direct 

In the automatic settings, select the option automatic reading (Replace the text in the editor 

with the contents of the clipboard and read it automatically), select the desired section of  
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text, and press CTRL+C. 
 

Using One-Click to create an audio file with Voice Reader Home 15 Direct  

In the automatic settings, select the option automatic export (Replace the text in the editor 

with the contents of the clipboard and export it automatically), select the desired section of 

text, and press CTRL+C. 
 

Using One-Click to paste text into the Voice Reader Home 15 Direct editor 

In the automatic settings, select the option automatic paste (Paste the contents of the 

clipboard into the editor), select the desired section of text, and press CTRL+C. The selected 

text will be pasted into the Voice Reader Home 15 Direct editor. There will be no automatic 

speech output.  If needed, this can be started manually by clicking Read .  
 

NOTE 

If possible, copy entire sentences and make sure that the closing punctuation character 

(e.g. period or question mark) is also included. This will ensure that Voice Reader Home 15 

Direct will intonate the individual words correctly in the sentence context.  

 

3.6 Manually read or export text from the clipboard 

If text that is in the clipboard should be read only as needed, not automatically, this can be 

done using the Read text from clipboard  command in the Voice Reader Home 15 Direct 

toolbar. Accordingly, the command for exporting to an audio file is:  Export text from 

clipboard . 
 

Instructions  

1. Select the desired section of text in any text-based document, e.g.  on a website, in a Word 

document or in an email, and copy it to the clipboard (Edit - Copy or CTRL +C). 
 
 

NOTE  

If possible, copy entire sentences and make sure that the closing punctuation character 

(e.g. period or question mark) is also included. This will ensure that Voice Reader Home 

15 Direct will intonate the individual words correctly in the sentence context.  
 

 

2. Select the desired command to have the text in the clipboard read or exported into an 

audio file.  Do this by clicking either the Read text from clipboard  or the Export text from 

clipboard  icon in the Voice Reader Home 15 Direct toolbar.  

In the course of reading, a progress bar will appear in Voice Reader Home Direct. 

 
To end playback prematurely, click on Stop reading 
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During export, you will be prompted to name the new audio file.  The format (MP3 or WAV) to 

be used, and the location for the export are controlled by the settings you have configured 

under Export options in the Options dialogue. 
 

3.7 Voice Reader Home 15 Direct Editor 

Voice Reader Home 15 Direct includes a small editor in which you can enter text to have it 

read or exported to an audio file.  

Enter the desired text manually, using the keyboard. 

You can also paste text from the clipboard that you have previously copied from another 

application. To copy the selected text, use the CTRL+C shortcut; use CTRL+V to paste into the 

Voice Reader Home 15 Direct editor.  

To read or export the text in the editor, click on the  (Read) or  (Export) icon to the right 

of the editor.   

In the course of reading, a progress bar will appear in Voice Reader Home Direct. 

 
 
You can end playback prematurely by clicking on Stop reading.  

During export, however, you will receive a prompt to name the new audio file.  The format 

(MP3 or WAV) to be used, and the location for the export are controlled by the settings you 

have configured under Export options in the Options dialogue. 
 

 

4. Adjusting options (Read and Export options) 
To customize the reading settings and export options for the conversion into an audio file in 

Voice Reader Home 15, please open the Options dialogue.  

Depending in which application module of Voice Reader Home 15 you are currently active, 

you will find the Options dialogue as follows: 
 

 From the Voice Reader Home 15 application window:  

Open the Read Tab and the Options dialogue   in the Settings group.   
 

 In Voice Reader Home 15 Direct:  

Click the Options  button in the toolbar.  
 

 

In the following, you’ll find an overview of all reading and export options.   

Most of these are available for the application window as well as for Voice Reader Home 15 

Direct.  

Options that only apply to a specific application have been designated accordingly. 
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Reading options  
 

Language 

If you have purchased and installed Voice Reader Home 15 voices for several languages, this is 

where you can choose another language for speech output.  

Voice 

Here your reading voice is shown. You can choose another voice if you own and have installed 

several Voice Reader Home 15 voices.   

Speech Speed 

Easily accelerate or slow down the speed of speech output using the slide control. The default 

speed is 100%.  By clicking the refresh button at the right border of the dialogue, you can 

restore the default setting of 100%. 

Pitch 

If needed, modify the pitch of the speech output using the slide control. The default value is 

100%. By clicking the refresh button at the right border of the dialogue, you can restore the 

default setting of 100%. 
 

Volume 

You can also adjust the volume of speech output in Voice Reader Home 15. By clicking the 

refresh button at the right edge, you can restore the default setting of 80%. 
 

NOTE  

In the Voice Reader Home 15 application window, you can also control speed, pitch and 

volume directly with their respective controls on the Read Tab. Language and voice can 

also be controlled directly using the respective drop-down menus in the Language & Voice 

group on the Read Tab.  
 

Read and select text (not available in Voice Reader Home 15 Direct).  

With this option, you determine the type of reading segmentation, i.e. whether the text is to 

be read and selected by word, sentence or section. Please note that the by word setting will 

divide the text into individual words, which means that every word will be read out separately 

and independently of the sentence context.  This type of segmentation may, for example, be 

suitable for the reading of foreign language words.    

The by sentence or by section settings are recommended for the fluent reading of standard 

text documents.  
 

Export options 

File format 

This lets you determine whether to export audio files in the WAV or MP3 format.  
 

 The WAV format is a standard audio file format. Data remain uncompressed and - burned to 

a CD ROM - can usually be played back by regular CD players.  Because the data remain  
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uncompressed, WAV files are comparatively large. Voice Reader Home 15 generates WAV 

files in the format 22050Hz, 16 bit. 
 

 Files in the MP3-Format are compressed and therefore significantly smaller than WAV files.  

Playback requires a specific program (e.g. Windows Media Player), or an MP3 player.  

Nowadays, many CD players also have the ability to play MP3 files.  Voice Reader Home 15 

generates MP3 files in the format 64kBit/sec. 
 

Standard export path 

This lets you determine in which folder to save audio files when exporting speech output. If 

you want to change the path, click the button next to the entry field and select the desired 

folder from the list.  
 

Prompt for file name at each export 

After activating this option, you can change the file name and export location each time you 

export. If the option is deactivated, the existing file name of the document that is open in the 

editor will be automatically assigned.   
 

Export audio file to the folder of the open text file 

If this option is activated, the audio file is saved to the same folder as the source text file from 

which it is being generated. 

If the option is deactivated, the audio file generated by Voice Reader Home 15 will be 

exported to the folder defined under Standard Export Path. 
 

Overwrite files with the same name without confirmation 

Audio file names are automatically assigned at the time of export.  This option determines 

what happens when the export folder already contains an audio file with the same name:  
 

 If the option is activated, the existing audio file will be replaced by the new one without  

confirmation. 

 If the option is deactivated, a dialogue comes up that lets you assign a different name to the 

new file, if necessary.  
 

At startup, automatically open the most recent document  

If this option is activated, the most recently used document will be opened the next time 

Voice Reader Home 15 is started.   
 

Keep reading bar in the foreground 

Activate this option if you want to make sure that no other application window will cover the 

Voice Reader Home 15 reading bar. 
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5. Notes on using audio files 
You can play the audio files generated by Voice Reader Home 15 directly on your PC or 

transfer them to another medium in order to play them with an external device. Voice Reader 

Home 15 allows you to save audio files in two formats: MP3 and WAV.  

You can set the desired format in the options menu. The format chosen depends on the 

playback device you wish to use:  

 

The MP3 format compresses the audio data, resulting in relatively small files. MP3 files can be 

played on all modern PCs (e.g. using Windows Media Player or Apple QuickTime) and can be 

transferred to MP3 players. Some CD players also support MP3 files, so that you can also burn 

the audio files to a CD-ROM.  

 

WAV files are not compressed and are thus larger than MP3 files. WAV files can be used on 

older Windows PCs without any additional software. If you have a CD burning program like 

Nero, you can also create an audio CD from WAV files, which can then be played like a music 

CD on all CD players. 
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6.  Appendix 

 

Keyboard Navigation 
 

The Voice Reader Home 15 editor supports operation by keyboard for many commands.  
 

Keyboard Commands (Shortcuts) 
 

File commands 
New file    CTRL+N 
Open file    CTRL+O 
Save file    CTRL+S 
Save file as    CTRL+W  
 

Edit 
Select all    CTRL+A 
Copy     CTRL+C 
Paste     CTRL+V or SHIFT+INST 
Undo last    CTRL+Z 
Redo last    CTRL+Y 
Find     CTRL+F 
Replace    CTRL+H 
 

General commands 
Open Options dialogue  CTRL+ALT+O 
Shut down   ALT+F4 
Menu and Accesskeys   
visible    ALT 
Maximize window  ALT + Space + X 
Minimize window  ALT + Space + N 
Zoom in editor  CTRL + turn mouse wheel 

 

Reading and exporting 
Read entire text   CTRL+ALT+P 
Export entire text   CTRL+ALT+A 

 
Show Accesskeys  
Please begin by pressing the ALT key. 
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In the Voice Reader Home 15 interface, individual GUI elements are represented for you in 
short form by numbers and letters.  Press these on the keyboard (one after another, not 
simultaneously) to access the desired element.  

For example, access the File Tab with ALT  F (press the keys one after another, not 

simultaneously!)  the Read Tab with ALT  R,  the Edit Tab with ALT  E, the Options button 

(Read Tab) with ALT  R  P.  
 

The Tab key ↹ : 
Using the Tab key, you can switch between the active GUI elements of a dialogue window.   

 
 

For example, to change the language of the buttons and menus please click onto the button 

GUI Language  (on the View tab in the group GUI Language) and change the setting via the 

Tab key  (English ↹  German ↹  Russian). The currently active field will be displayed with a 

blue selection.  

The Arrow keys ↑ and ↓ : 
Use the arrow keys to navigate through an active drop-down list entry.   
 

The Control key (CTRL): 
By holding the CTRL key down and using the Tab key (for switching to a button), or 
alternatively, the arrow key (when switching to a list entry), you can switch between different 
sections of a dialogue window.  
 

The Enter key: 
The Enter key is used to confirm a selection.  
 

Application examples 
 

a) Increase speech speed 

ALT  R  C  ↑ press arrow key several times, until the desired speed level is reached and press 

Enter to confirm. 
 

b) Switch voice (if you have installed more than one voice of Voice Reader Home 15):  

ALT R  2  CTRL  (press and hold) + ↓ press arrow key several times, until the desired voice 

has been selected,  then press Enter to confirm the selection. 
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Software License Agreement  

 

Please install the program only after you have carefully read through this software license agreement. 

By installing the software, you agree to the terms and conditions of this software license agreement. 

The program package contains programs and associated documentation, hereinafter referred to as 

"works". The works are protected by copyright. Linguatec or third parties have property rights to these 

works. If the rights belong to third parties, Linguatec has appropriate rights of use to the works. 

Linguatec authorizes the legal buyer of the program package (customer) to use the works in 

accordance with the following conditions. The right of use becomes null and void if the customer 

violates these conditions of use, or the right of use is cancelled in accordance with the following 

regulations. 
 

The customer is entitled: 

1.     in agreement with copyright law, to use the program for the purpose of processing or for 

observing, investigating or testing on one computer for their own purposes.  

2.     to prepare machine-readable or printed copies including a backup from the machine-readable 

part of the program, as long as this is necessary for use in accordance with the agreement. Use 

within a network is not permissible however. Specific programs can include mechanisms that 

restrict or prevent copying. 
 

The customer is not entitled: 

1.     to replicate and translate the works or even partially decompile the machine language code 

(object code) of the works into any other code form in any manner other the one described 

above. The right to decompilation in certain exceptions in accordance with copyright remains 

unaffected. 

2.     to rent or to lease the works or to use them for purposes other than one’s own purposes. 

3.     to make the audio files generated using Voice Reader available commercially in electronic format 

either generally or selectively to several recipients, or to offer the conversion of texts into audio 

files as a professional service to third party. 

4.     to transfer the works including these conditions of use to a third party (new buyer) without 

previous written consent from Linguatec or to allocate sublicenses to third parties. 

Furthermore, the customer shall enclose the copyright notice included in the works in each copy, each 

revision and all program modules of the works that are connected to other programs, as well as on the 

associated data carriers. All copies of the works including all program modules are also subject to 

these conditions of use. If the license holder is in breach of these agreement provisions, he/she shall 

be obliged to return the software package to Linguatec without delay. 

The licensor, his employees and representatives shall only be liable for any contractual or non-

contractual damage if the damage can be attributed to gross negligence or a deliberate act. Liability 

for secondary damages is excluded in all cases. 

 
© 2018 Linguatec GmbH 
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